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1. Ohjelma 
Avoimen koodin 

ohjelmisto 
 Audacity on ilmainen avoimen lähdekoodin ohjelmisto äänen 

muokkaamista varten usealla ääniraidalla. Audacity äänittää, toistaa ja 
muokaa. WAV, AIFF, MP2 ja MP3, FLAC, OGG äänitiedostoja voidaan 
tuoda ja viedä. Se käyttää tuttuja yleisiä toimintoja kuten ”leikkaa”, 
”kopioi” ja ”liitä” sekä rajoittamaton ”kumoa” (Undo). Sillä voi 
yhdistää ja lisätä äänitehosteita ja säätää äänen voimakkuuksia helposti. 
 

Versiot  Audacityä kehittävät harrastajat maailmanlaajuisesti. Tässä ohjekirjassa 
käsitellään version 2.0.0. toimintoja. Uudemmat versiot toimivat samalla 
periaatteella – ominaisuuksia niissä saattaa olla kuitenkin enemmän ja 
voivat toimia vakaammin. Audacity on käytettävissä useissa 
käyttöjärjestelmissä kuten Windows 98 ja uudemmat, Mac OS X ja 
Linux/Unix 
 

Tuki  Katso http://forum.audacityteam.org/ 
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2. Lataus ja asennus 
Lataus ja asennus  Audacityn voi ladata osoitteesta 

http://audacity.sourceforge.net/download/ 
Samasta paikasta löytyy myös perustietoa ja ohjeita. Varmista, että 
lataat oman koneesi käyttöjärjestelmässä toimivan version. Windows ja 
MacOS käyttöjärjestelmissä ohjelman asennus tapahtuu smalla tavalla 
kuin muidenkin ohjelmien asennus. Useissa Linux-jakeluissa Audacity 
on jo valmiiksi asennettu – se toisin saattaa olla vanhempi versio. 
 

Koodekit (Audio-
Codecs) 

 MP3-tiedostojen luomista varten on ladattava erillinen ”lame MP3 
encoder” – lisenssisyistä johtuen  se pitää ladata ja asentaa erikseen. 
Mene osoitteeseen http://audacity.sourceforge.net/download/ 
, josta löydät latausohjeet MacOS:lle and Windowsille; on myös 
mahdollista ladata lame-koodekki suoraan Audacitystä klikkaamalla 
ohjelmassa  Edit > Preferences > Libraries. Lame-
koodekki Linuxille on helppo asentaa. Se löytyy valmiina rpm-
pakettina -> http://packman.links2linux.de/.  Samasta paikasta voit 
lukea käyttöehdot ja käyttövinkkejä. 
 
Jos haluat käyttää muita tallennusformaatteja, kuten AC3, WMA tai 
M4A (MP4), sinun pitää ladata 
erillinen Fmpeg-kirjasto (Edit 
> Preferences > 

Libraries). 
 
 
 

 

 

 

 

 

 

 

 

http://audacity.sourceforge.net/download/
http://audacity.sourceforge.net/download/
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Mukautukset (esim. 
ohjelman 

käyttöliittymän kielen 
valinta) 

 Jotta voit työskennellä helposi Audacityssä, olisi aluksi tehtävä joitakin 
mukautuksia ohjelmaan valitsemmalla menusta File > 
Preferences: 
 

 Menussa Libraries yllä mainittu “lame MP3 encoder” pitää 
ottaa Audacityn käytettäväksi klikkaamalla Find Library. 
Linuxille tarvittava tiedosto on libmp3lame.so - Windowsille 
lame_enc.dll. On suositeltavaa käyttää suhteellisen korkeaa ns. ”Bit 
ratea” MP3-tiedostoja talletettaessa.  (esim. 192/256), jotta MP3-
tiedostojen äänen taso säilyy mahdollisimman hyvänä. Internettiä 
varten talletettaessa valitaan yleensä pienempi “Bit rate” (katso kappale 
Tallennus). 

 Ennen kuin aloitat äänitiedostojen editoinnin on syytä asettaa   
Import/Export –valinnasta   Make a copy of 
uncompressed audio files before editing päälle. Tällä 
varmistat, että originaali tiedosto säilyy alkuperäisessä muodossa ja 
editoit aina alkuperäisen kopiota. 

 Kun talletat projektisi haluat myös että äänidata on mukana 
samassa paikassa.  Kohdassa  Projects  laita päälle  Always copy 
all audio into project. 

 Kohdassa  Tracks  laita päälle  Update display 
while playing, jotta näytöllä näkyvä kursori seuraa 
kuuntelukohtaa. 

 Kohdass  Interface  voit valita kielivaihtoehdon, jolla 
menut näytetään (esim. Suomi). Huomaa kuitenkin, että kaikkia 
menujen osia ei välttämättä ole vielä suomennettu. 

 Kohdassa  Tracks pitäisi  Enable cut lines  Olla 
valittuna (katso kappale 6) . 
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3. Ensimmäinen äänitys ja kuuntelu 
Äänitys ja äänen 

voimakkuus 
 Audacity avautuu aluksi näyttämällä tyhjän alueen ilman ääniraitoja. 

Kun äänität tai tuot ohjelmaan äänitiedoston Audacity luo uuden 
ääniraidan. Jos tietokoneessa on toimiva äänitys, voit aloittaa 
tallennuksen painamalla punaista äänityspainiketta. Äänitettävän äänen 
voimakkutta ohjataan liukusäätimellä, jossa on mikrofonin symboli. 
Sisään tulevan signaalin reitti (Mic, line in, ...) valitaan 
punnahdusikkunasta säätimen vieressä.  Ulkoiset äänilaitteet kuten 
MiniDisc-soittimet pitäisi olla aina kytketty tietokoneen äänikortissa 
”Line In”-liitäntään, koska sisääntuleva signaali saattaa mennä särölle 
jos laite on kytketty esim. Mic-liitäntään.  
 
Äänityksen voimakkuuden tasoa voi tarkkailla näytöllä. Sen ei pitäisi 
ylittää -6dB tasoa. Näin varmistat, että yllättävät äänipiikit evät mene 
särölle. Jokainen uusi äänitys avaa uuden ääniraidan, jotta et 
vahingossa äänittäisi Audacityssa jo olevan materiaalin päälle. 
 
Painamalla  Shift-näppäintä kun klikkaat äänitysnappia tai  Shift  
+  R  samanaikaisesti voit jatkaa äänitystä myös jo valittuna olevaan 
raitaan. 
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Kuuntelu  Voit aloittaa (play), tilapäisesti keskeyttää  (pause)  tai  pysäyttää (stop) 
tutuilla napeilla näytön yläosassa.  Voit myös vielä helpommin aloittaa 
kuuntelun ja pysäyttää sen painamalla välilyöntinäppäintä. Aikajanaa 
klikkamalla voit heti aloittaa kuuntelun haluamastasi kohtaa ilman että 
valittu alue muuttuu. 
(TARKEÄÄ: Kun  Paussi-nappi on päällä/alhaalla et voi editoida 
ääntä! Tämä on yleisin ongelma kun ihmiset ihmettelevät miksei 
editointi toimi) 
 

Pikakuuntelu  Äänen pikakuuntelu on myös mahdollista. Kuuntelun aikana voit 
nopeasti hypätä muutaman sekunnin eteenpäin painamalla “nuoli 
oikealle”-näppäintä näppäimistöllä  (taaksepäin hyppääminen: ”Nuoli 
vasemmalle”-näppäin). Tämän hypyn pituuden voi määritellä 
menemällä menuun ”Edit > Preferences > Playback”. 

 
Toinen kätevä toiminto on kuuntelu
eri nopeuksilla. Valitse soittonopeus

ja klikkaa vihreää kolmiota (kuvassa). 
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4. Äänen tuonti tiedostosta Audacityyn 
Tuonti (import)  Audacityyn voi tuoda WAV, MP2, MP3, AIFF ja OGG formaatissa 

olevia äänitiedostoja. 
 
Helpoin tapa tuoda äänitiedosto on raahata hiirellä tiedosto esim. 
tietokoneen työpöydältä ja pudottaa se Audacityn ikkunan päälle. 
 
Toinen tapa on käyttää menua  Tiedosto > Tuo (Project > Import 
audio) kun haluat tuoda lisää äänitiedostoja editointiprojektiin mukaan. 
Tuodut tiedostot luovat aina oman uuden ääniraidan. FFmpeg kirjaston 
avulla (jos sellainen on asennettu) voit tuoda myös monia muita 
tiedostotyyppejä kuin mitä yllämainitut (katso kappale 2). 
 
Useampi Audacity projekti voi olla samanaikaisesti avoinna omissa 
ikkunoissaan ja näiden välillä voit kopioda äänen osia edes-takaisin. 
Tämä on katevää, jos esim. haluat isommasta tiedostosta kopioida osia 
toiseen tiedostoon. Valitse  Tiedosto > Uusi (File > Open)  jos 
haluat avata toisen projektin uuteen ikkunaan.  
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5. Näkymän säätäminen 
Näkymä vaakatasossa  Ennen työskentelyn aloittamista on hyvä säätää ikkuna ja sen näkymä 

itselleen sopivaksi. Kokoruututilaan pääsee painamalla F11. Äänen 
näkymä vaakatasossa säädetään numeronäppäimistön + ja – napeilla. 
Vaihtoehtoisesti voi suurennustasoa säätää myös hiiren rullalla kun 
Ctrl –näppäintä pidetaan pohjassa. Ja lopuksi saman asian voi tehdä 
vielä käyttämällä suurennuslasi-ikoneja. Nämä ikonit ovat: suurennus, 
pienennys, sekä projektin tai valitun 
alueen sovittaminen näytölle.  

Näkymä 
pystysuunnassa 

 Tätä toimintoa tarvitaan harvemmin ja vain erikoistilanteissa. 
Ääniraidan mittakaavan muuttaminen pystysuunnassa onnistuu hiiren 
avulla. Hiiren kohdistin muuttuu kaksoisnuoleksi, kun se siirretään 
ääniraidan reunalle. 

 
Jokaisen ääniraidan vasemman laidan alaosassa on kolmiosymboli, 
josta klikkaamalla raidan ottama tila näytöllä voidaan 
pienentää/suurentaa. 
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Nimiraita  Nimiraita saattaa auttaa ettet huku omaan materiaaliisi. Nimiraitaa 
käyttämällä voi nimetä kohtia äänimateriaalissa. Valitse Raidat > 
Lisää Uusi > Label Track (nimiraita) kun haluat luoda 
uuden nimiraidan. Tai vaihtoehtoisesti: Ctrl + B  kun haluat luoda 
nimiraidan ja samalla luoda kohdistimen kohdalle merkinnän. Voit 
kirjoittaa merkinnän (tai valitun alueen) nimen kunhan nimiraita on 
aktiivisena (valittuna). Nimiraidan merkintöjä voit vapaasti siirrellä ja 
merkinnän voi poistaa nimiraidalta jättämällä sen nimi tyhjäksi.  
Äänityksen ja toiston aikana voit luoda (Ctrl + N) uusia 
merkintöjä, mutta ole varovainen ettei äänityksesi pysähdy 
vahongossa: jos nimiraita ei ole aktiivinen (valittu), niin 
välilyöntinäppäin pysäyttää äänityksen. 
 

Työkaluryhmät  Audacityn käyttöliittymää voi tarvittaessa muokata. Jokaisen 
työkaluryhmän vasemmassa laidassa on kuvan mukainen alue. 

Hiiren kohdistimen ollessa alueen kohdalla näkyy työkaluryhmän 
toiminto. Työkaluryhmiä voit myös mielesi mukaan siirrellä haluamiisi 
paikkoihin tai kokonaan irroittaa omiksi kelluviksi pikku ikkunoiksi. 
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6. Editointi monitoimitilassa 

Monitoimitila 

 

 “Monitoimitila” nopeuttaa ja helpottaa 
editointia. Tilan ollessa aktiivinen lähes kaikki 
työskentelytilat ovat käytettävissä ilman, että 
tarvitsee erikseen valita työskentelytila kuvan 
työkaluvalinnasta. Alla oleva ohje olettaa, että monitoimitila on 
aktiivinen, eli “*”-nappi on valittuna. Tämä tarkoittaa, että hiirellä voi 
suorittaa kolmea erityyppistä toimintaa riippuen siitä missä kohtaa 
ääniraitaa hiiren kohdistin on. Toisilla työkaluvalintanapeilla voidaan 
laittaa eri toimintoja päälle ja pois päältä.  

Toiminto #1: 

Alueen valinta 

(toimii kuten alueen 
valintatyökalu) 
 

 Kun hiiren kohdistin näkyy monitoimitilassa “I”-kuvana voit valita 
ääniraidasta tai useammasta raidasta haluamiasi kohtia. Usein on 
tarpeellista säätää osien alku- ja loppukohtia. Säätäminen tapahtuu 
hiirellä osien reunakohdista. Valitun osan alku- ja loppukohta ovat 
näkyvillä tilarivillä Audacityn ikkunan alaosassa. Toisto/kuuntelu 
tapahtuu valitun alueen puitteissa. Aikajanaa klikattaessa toisto alkaa 
siitä kohtaa muuttamatta valittua aluetta. 

Leikattavan kohdan 
esikuuntelu 

 Tämä toiminto on hyödyllinen juuri ennen valitun kohdan poistamista. 
Valittuasi mahdollinen poistettava alue voit kuunnella miltä lopputulos 
kuullostaisi leikkauksen jälkeen painamalla C-näppäintä (tai pitämällä 
Ctrl–näppäin pohjassa kun klikkaat toistonappia). Näin kuunnetaessa 
kuuntelu alkaa muutamaa sekuntia ennen valittua aluetta, hyppää 
valitun aluen yli ja pysähtyy muutamaa sekuntia valitun alueen 
jälkeen. Esikuuntelun pituuden voi määritellä valikossa Muokkaa > 
Asetukset > Toisto. 
 

Kuuntelu kohti 
valittua aluetta tai sen 

alusta. 

 B-nappia painamalla voi myös aloittaa kuuntelun. Tällöin hiiren 
kohdistimen paikka vaikuttaa kuuntelun alku ja loppukohtaan. Jos 
kohdistin on ennen valittua aluetta, niin kuuntelu päättyy valitun 
alueen alkuun. Jos kohdistin on valitun alueen alkuosassa, niin 
kuuntelu alkaa valitun alueen alkukohdasta ja päättyy kohdistimen 
kohtaan. Jos kohdistin on valitun alueen loppuosassa, niin kuuntelu 
alkaa kohdistimen kohdassa ja päättyy alueen lopussa. Kohdistimen 
ollessa valitun alueen jälkeen kuuntelu alkaa valitun alueen 
loppukohdasta. 
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Valitun alueen kohdan 
tallennus 

 Valitun alueen kohdan voi tallettaa ja palauttaa. Katso menu  
Muokkaa > Tallenna alue ja Palauta alue. 

Kopionti, liittäminen 
ja poistaminen 

 Ääniraidan osia editoidaan tutuilla komennoilla, kuten Ctrl + C 
kopioi alueen ”leikepöydälle” (clipboard), Ctrl + V liittää 
leikepöydällä olevan kopion kohdistimen kohdalle, 
Ctrl + X ja Del –nappi poistavat kohdan. Näppäinten lisäksi 
käytettävissä on Audacityn yläosassa olevat editointinapit.  Huom! 
Leikkausmerkkejä ei luoda kun ääniraidan osia poistetaan Del -napilla 
tai Backspace –napilla (katso seuraava sivu ”Leikkausmerkit”). 
Useampien ääniraitojen kanssa työskennellessä valittu alue voidaan 
poistaa näistä samanaikaisesti. Esimerkiksi jos aluat poistaa valitun 
alueen raidasta #1 ja #3 mutta ei raidasta #2, niin toimi seuraavalla 
tavalla: Valitse alue raidalta #1 - Shift+Klikkaus raidan #3 
otsikkoaluetta raidan vasemassa laidassa – poista alueet Ctrl + X. 
Kopioituja kohtia voidaan liittää haluttuihin raitoihin kuten yllä on 
mainittu, mutta niitä voidaan siirtää myös toisista avoinna olevista 
projekteista. Tällöin on tärkeä pitää mielessä, että raitojen 
näytteenottotaajus (sampling frequency) on sama molemmissa 
projekteissa (yleensä 44,1kHz). 

Raitojen yhdistäminen  Tosinaan on järkevää editoida materiaalia useissa eri ääniraidoissa, 
varsinkin kun työn alla on monimutkaisempia projekteja. Raitojen 
yhdistäminen helpottaa kun käsittelet materiaalia monissa eri raidoissa 
ja raitoja alkaa kertyä turhan paljon. Projektin kokonaiskuvan 
säilyttämiseksi on tarpeen välillä yhdistää (miksata) useita raitoja 
yhteen. 
Raidat > Miksaa ja renderöi toiminnolla yhdistät valitut 
raidat yhteen. 

Leikkausmerkit  “Leikkausmerkit” (cut lines) -toiminto aktivoituna helpottaa 
työskentelyä kun poistetaan ääniraidan osia. Poistettu kohta jää 
leikkauksen jälkeen näkyville leikkausmerkkinä. Klikkaamalla tätä 
merkkiä leikattu kohta saadaan tarpeen vaatiessa palautettua. 
Leikkausmerkit-toiminto ei ole oletusarvoisena päällä vaan se pitää 
aktivoida menussa Muokka > Asetukset > Raidat. 
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Toiminto #2: 

Äänen osien siirtely 

  

 

 Valittujen äänen osien siirtely onnistuu (kun “monitoimitila” on 
aktiivinen) Ctrl-napin ollessa pohjassa ja sen jälkeen hiirtä 
liikuteltaessa. Useita eri osia voi siirtää samanaikaisesti kun ne kaikki 
ovat valittuna ryhmäksi.  Kokonaisen ääniraidan kaikkia osia voi 
siirtää kun Ctrl + Shift –näppäimet ovat pohjassa. 
Kun osia siirretään raidan alkuun voi osan alku helposti siirtyä liikaa 
vasemmalle ja kadota ääniraidalta. Tämä on korjattavissa kun valitaan 
menusta Raidat > Kohdista raidat > Kohdista 
nollakohtaan. 
Ääniraidan osia voi jakaa käyttämällä “Split” toimintoa Muokkaa > 
Clip Boundaries > Split tai painamalla  Ctrl + I; tämä 
katkaisee osan kohdistimen kohdalla. Osia voit liittää myös yhteen 
siirtämällä ne vierekkäin ja klikkaamalla niiden yhtymäkohtaa. 

Synkronointilukitus 
(Sync-Lock) 

 Toiminto menussa Raidat > Sync-Lock Tracks yhdistää 
raidat aika-akselilla siten, että toiminto yhdellä raidalla (esimerkiksi 
leikkaus) vaikuttaa muihin raitoihin. Raitojen synkronointi on merkitty 
pienellä kellon kuvalla raitojen vasemmassa osassa.  

Toiminto #3: 

Äänen 
voimakkuuspisteet 

(verhotyökalu) 

 

 Äänenvoimakkuuspisteitä (volume points) voi luoda ääniraidan raja-
alueella. Katso seuraava kappale “Äänen voimakkuden säätäminen”. 
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7. Äänen voimakkuuden säätäminen 
Viisi vaihtoehtoa  Äänen voimakkuutta voi säätää koko ääniraidalle, ääniraidan sisällä ja 

automaattisesti: 

1. 

Label 

 Koko raidan äänenvoimakkuutta voi muuttaa säätimellä, joka löytyy 
ääniraitojen vasemmasta osasta. Tällä säätimellä voi muutta 
voimakkuutta 3dB (desibeli) askelilla. Painamalla Shift tämä 
muutos on 1 dB. 
 

2. 

Voimakkuuspisteet 
(“Ääniverho”) 

 Jos, kuten kappaleessa 6 kuvattin, 
monitoiminto on aktiivinen, voit 
muuttaa äänen voimakkuutta 
ääniraidan sisällä 
voimakkuuspisteillä. Ääniraidan 
reunalla kohdistin muuttuu 
kahdeksi valkoiseksi kolmioksi. 
Tällöin voit vapaasti muuttaa 
siinä kohdassa äänen voimakkutta. Näitä pisteitä voi myöhemmin 
siirrella tarpeen mukaan tai poistaa raahamalla niitä ääniraidan 
ulkopuolelle.  

3. 

Häivytys 

 On hyvin yleistä, että äänitys – esim. lyhyt lainaus tai musiikki – 
saattaa alkaa ja loppua ns. häivytyksellä (fade). Helpoin tapa suorittaa 
häivytys on valita ensin alue ääniraidasta ja sen perään valita menusta  
Efekti > Häivytys sisään tai Häivytys ulos. Tämän 
toiminnon ero voimakkuuspisteillä suoritettuun häivytykseen on se, 
että sitä ei voi myöhemmin muuttaa.  

4. 
Automaattinen välttely 

(Auto duck) 

 Hyvin käytännöllinen on 
Efekti > 

Automaattinen 

välttely kun 
työskennellään 
ulkomaankielisen 
materiaalin kanssa ja 
halutaan käännetty 
materiaali sen päälle. 
Tällöin käytetään kahta eri eri ääniraitaa - alkuperäinen ja käännetty 
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versio. Käännettyä tekstiä sisältävän raidan ääni automaattisesti 
vaimentaa alkuperäisellä kielellä olevan ääniraidan ja kun käännetyssä 
raidassa on hiljainen kohta, niin alkuperäisellä kielellä olevan raidan 
äänen voimakkuus nousee automaattisesti kuultavaksi. 

5. 

Vahvistus 

 Toiminnolla  Efekti > Vahvistus voidaan valitun kohdan 
äänen voimakkuutta nostaa/laskea haluttu määrä. Myös koko projektin 
äänen voimakkuutta voi muokata valitsemalla kaikki raidat painamalla 
Ctrl + A. Olisi suotavaa, että maksimi äänenvoimakkuus ei ylittäisi  
-1dB tasoa. Tämä varmistaa, että missään vaiheessa ääni ei mene 
särölle. Vaihtoehtoisesti voit “normalisoida” äänen voimakkuuden 
tietylle tasolle valitsemalla Efekti > Normalisoi, jossa on 
valmiina -1dB taso valittuna. Jos käytät useita raitoja jotka soivat 
samanaikasesti on hyvä jättää maksimi taso vieläkin alhaisemmaksi 
(esim. -3db). Tällöin yhtäaikaa soivat raidat eivät niin helposti mene 
kuuntelussa särölle. Vaikka yhdessä soivien raitojen erillinen 
maksimimivoimakkuus ei olisi lähellä 0db tasoa, niin yhdessä 
kuunneltuna saattaa ääni silti mennä särölle. Digitaalinen ääni ei 
koskaan saisi yltää 0dB tasolle. 
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8. Tallennus ja vienti (export) 
Useita vaihtoehtoja  1. Voit luoda ja tallettaa moniraitaprojekteja Audacityllä ja 

myöhemmin uudelleen avata ne jatkaa työskentelyä 
tallennusta edeltäneestä tilasta. Tätä tallennusta ei voi käyttää 
muissa ohjelmissa. 

2. Voit myös viedä (export) äänen osia tai koko projektin yhdeksi 
äänitiedostoksi (.wav, mp3, ...). Tämä on yleensä se toiminto 
kun editointi valmis ja halutaan, että editoitu materiaali on 
toistettavissa muissa laitteissa/ohjelmissa. 

 

Tallenna projekti  Tiedosto > Tallenna projekti tai Tallenna 
projekti nimellä  tallettaa koko työskentelytilan tiedostoon, 
jonka loppuosa on nimeltään *.aup.  Tiedosto > Avaa tuo 
projektin takaisin Audacityyn ja voit jatka työskentelyä tallennusta 
edeltäneestä tilasta. Itse äänimateriaali on talletettuna saman kansion 
sisään pieninä äänitiedostoina  (*.au , Sun-audiofile). 

   

Vienti eri tiedosto- 
formaatteihin MP3 , 
OGG, WAV,  M4A, 

WMA ... 

 Tiedosto –menussa on eri vientitoimintoja. Vie –toiminto 
miksaa/yhdistää koko projektin ääniraidat yhteen ja tallettaa tuloksen 
yhteen tiedostoon. Vie valinta –toiminto luo ja tallettaa 
äänitiedoston vain valituista ääniraidoista. Viedessä voit valita myös  
tallennusformaatin. Valitse WAV kun haluat talletetun tiedoston äänen 
olevan ns. CD-tasoa tai MP3 tai OGG kun haluat talletuksen 
vähemmän tilaa vievänä (pakattuna). Pakatussa formaatissa äänen 
laatu ei ole aivan yhtä hyvä kuin pakkaamattomassa WAV-formaatissa. 
Yleensä tätä eroa ei huomaa, mutta jos pakattua äänitiedostoa avataan 
ja talletetaan useamman kerran sen laatu alkaa kärsiä.  Pakkauksen 
tiheys voidaan valita Vienti -ikkunassa kohdassa Asetukset. 
MP3-tiedostoja viedessä ”lame”-koodekki pitää olla asennettuna (katso 
kappale #2 Lataus ja Asennus). 
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Vienti useampaan 
tiedostoon 

 Joskus saatat haluta tallettaa lopputuloksen muilla tavoilla esimerkiksi 
CD:tä varten saatat haluta CD:lle useita eri raitoja kappalemerkintöjen 
mukaan. Tai saatat ehkä haluta tallettaa pitkän live-esityksen eri 
kappaleet eri MP3-tiedostoihin. Näitä toimintoja varten on Tiedosto 
-menussa Vie moneen tiedostoon -valinta. 
Ensin on hyvä luoda uusi nimiraita (label track), johon merkitään eri 
esitysten kohdat niminä. Tämän jälkeen Vie moneen tiedostoon 
-toiminto luo automaattisesti erilliset äänitiedoston nimiraidan tietojen 
mukaan. 
 

Moniraitaääni  Audacityllä voi tallettaa myös 
moniraitaääntä, jota tarvitaan 
esim. ns. surround 
systeemeissä. Muokkaa > 
Asetukset > Tuo/Vie 
pitää  olla “Use Custom Mix” 
valittuna ja vienti pitää 
tapahtua formaatissa, joka 
hyväksyy useammt ääniraidat 
(esim. WAV). 
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9. Pikanäppäimet 
 
 
 
 

Näppäinasetukset  Monet pikanäppäimet ovat valmiiksi asetettu kun asennat Audacityn. 
Pikanäppäimiä käyttäen työskentely nopeutuu huomattavasti tottuneen 
editoijan käsissä. Pikanäppäimiä voi helposti lisätä ja muokata 
mielensä mukaan. Katso  Muokkaa > Asetukset > 
Näppäimistö. 
 

 
... 
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Lista pikanäppäimistä 
 
Uusi projekti Ctrl+N 

Avaa... Ctrl+O 

Sulje Ctrl+W 

Tallenna Projekti Ctrl+S 

Tuo Ctrl+Shift+I 

Lopeta/poistu Ctrl+Q 

Kumoa (undo) Ctrl+Z 

Tee uudelleen (redo) Ctrl+Shift+Z 

Leikkaa Ctrl+X 

Jaa ja leikka Ctrl+Alt+X 

Kopioi Ctrl+C 

Liitä Ctrl+V 

Liitä teksti nimikkeeseen Ctrl+Alt+V 

Trimmaa Ctrl+T 

Poista Ctrl+K 

Jaa ja poista Ctrl+Alt+K 

Mykistä ääni Ctrl+L 

Jaa Ctrl+I 

Jaa uudeksi Ctrl+Alt+I 

Liitä yhteen Ctrl+J 

Irroita hiljaisista kohdista Ctrl+Alt+J 

Kopioi Ctrl+D 

Leikkaa Alt+X 

Mykistä ääni Alt+L 

Jaa nimikkeet Alt+I 

Liitä nimikkeet Alt+J 

Valitse kaikki Ctrl+A 

Älä valitse mitään Ctrl+Shift+A 

Aseta valinnan vasen reuna [ 

Aseta valinnan oikea reuna ] 

Raidan alku kohdistimeen Shift+J 

Kohdistin rainan loppuun Shift+K 

Valitse kaikki raidat Ctrl+Shift+K 

Valitse synkronoidut raidat Ctrl+Shift+Y 

Hae nollakohta Z 

Kohdistin raidan alkuun J 

Kohdistin raidan loppuun K 
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Asetukset... Ctrl+P 

Lähennä + 

Normaali koko Ctrl+2 

Loitonna - 

Sovita ikkunan kokoon Ctrl+F 

Sovita pystysuunnassa Ctrl+Shift+F 

Sovita valinnan kohdalle Ctrl+E 

Penennä kaikki raidat Ctrl+Shift+C 

Suurenna kaikki raidat Ctrl+Shift+X 

Toista aina uudestaan alusta Shift+Space 

Paussi P 

Hyppää alkuun Home 

Hyppää loppuun End 

Äänitä R 

Ajastettu äänitys... Shift+T 

Jatka äänitystä Shift+R 

Uusi ääniraita Ctrl+Shift+N 

Miksaa ja renderöi raidat uudeksi Ctrl+Shift+M 

Mykistä kaikki raidat Ctrl+U 

Vapauta raitojen mykistys Ctrl+Shift+U 

Lisää merintää valintaan Ctrl+B 

Lisää merkintä toistokohtaan Ctrl+M 

Kertaa edellinen efekti Ctrl+R 

Valintatyökalu F1 

Verhotyökalu F2 

Piirtotyökalu F3 

Suurennostyökalu F4 

Siirtotyökalu F5 

Monitoimitila F6 

Seuraava työkalu D 

Edellinen työkalu A 

Toista/Pysäytä Space 

Toista/Pysäytä ja aseta kohdistin Shift+A 

Toista yksi sekunti 1 

Soita valintaan saakka B 

Esikuuntele leikkauskohta C 

Siirrä valinta alkuun Shift+Home 

Siirrä valinta loppuun Shift+End 

Siirry edelliselle raidalle Up 
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Siirry edelliselle raidalle ja valitse Shift+Up 

Siirry seuraavalle raidalle Down 

Siirry seuraavalle raidalle ja valitse Shift+Down 

Vaihda aktiivinen raita Return 

Vaihda aktiivinen raita NUMPAD_ENTER 

Kohdistin vasemmalle Left 

Kohdistin oikealle Right 

Kohdistimen lyhyt hyppy vasemmalle , 

Kohdistimen lyhyt hyppy oikealle . 

Kohdistimen pitkä  hyppy vasemmalle Shift+, 

Kohdistimen pitkä hyppy oikealle Shift+. 

Jatka valintaa vasemmalle Shift+Left 

Jatka valintaa oikealle Shift+Right 

Lyhennä valinnan alkua Ctrl+Shift+Right 

Lyhennä valinnan loppua Ctrl+Shift+Left 

Muuta kohdistetun raidan panorointia Shift+P 

Siirrä kohdistetun raidan panorointia vasemmalle Alt+Shift+Left 

Siirrä kohdistetun raidan panorointia oikealle Alt+Shift+Right 

Muuta kohdistetun rainan äänen voimakkuutta Shift+G 

Lisää kohdistetun raidan äänen voimakkuutta Alt+Shift+Up 

Hiljennä kohditettua raitaa Alt+Shift+Down 

Avaa menu kohdistetussa raidassa Shift+M 

Kohdistetun raidan soolo päälle/pois Shift+S 

Sulje kohdistettu raita Shift+C 

Kokoruututila päälle/pois F11 
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